# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Introduction</td>
</tr>
<tr>
<td></td>
<td>Audience</td>
</tr>
<tr>
<td></td>
<td>Documentation Conventions</td>
</tr>
<tr>
<td></td>
<td>Related Documents</td>
</tr>
<tr>
<td></td>
<td>Before You Begin</td>
</tr>
<tr>
<td></td>
<td>Browser and Environment Requirements</td>
</tr>
<tr>
<td>2</td>
<td>Configuring ATG Self Service Overview</td>
</tr>
<tr>
<td></td>
<td>Starting ATG Self Service</td>
</tr>
<tr>
<td></td>
<td>ATG Self Service Sites</td>
</tr>
<tr>
<td></td>
<td>The Default ATG Self Service Site</td>
</tr>
<tr>
<td></td>
<td>Site Settings Hierarchy</td>
</tr>
<tr>
<td>3</td>
<td>Configuring Solutions</td>
</tr>
<tr>
<td></td>
<td>Deploying Solution Attachments</td>
</tr>
<tr>
<td></td>
<td>Creating Problem Categories and Assigning Ticket Queues</td>
</tr>
<tr>
<td></td>
<td>Configuring Hot Solutions, Top Questions, and Best Bets</td>
</tr>
<tr>
<td></td>
<td>Configuring Hot Solutions</td>
</tr>
<tr>
<td></td>
<td>Setting the Maximum Number of Solutions to Display</td>
</tr>
<tr>
<td></td>
<td>Running ATG Self Service on a Production Environment</td>
</tr>
<tr>
<td>4</td>
<td>Identifying User Segments</td>
</tr>
<tr>
<td></td>
<td>Prerequisites</td>
</tr>
<tr>
<td></td>
<td>Selecting User Segments</td>
</tr>
<tr>
<td></td>
<td>Ordering Segments</td>
</tr>
<tr>
<td></td>
<td>Removing Segments</td>
</tr>
<tr>
<td>5</td>
<td>ATG Self Service Global Settings</td>
</tr>
<tr>
<td></td>
<td>Configuring Anonymous User Access</td>
</tr>
<tr>
<td></td>
<td>Filtering Cookies</td>
</tr>
<tr>
<td></td>
<td>Configuring Site Information</td>
</tr>
<tr>
<td></td>
<td>Site Landing Page</td>
</tr>
<tr>
<td>6</td>
<td>Configuring an ATG Self Service Site</td>
</tr>
<tr>
<td></td>
<td>Creating an ATG Self Service Site</td>
</tr>
<tr>
<td></td>
<td>Copying Site Settings</td>
</tr>
</tbody>
</table>
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding External User Segments to a Site</td>
<td>24</td>
</tr>
<tr>
<td>Controlling Solution Access at Sites</td>
<td>25</td>
</tr>
<tr>
<td>Creating a Site-Specific External User Segment</td>
<td>26</td>
</tr>
<tr>
<td>Unstructured Content and Sites</td>
<td>27</td>
</tr>
<tr>
<td>Selecting a Site Skin</td>
<td>27</td>
</tr>
<tr>
<td>Default Skins</td>
<td>28</td>
</tr>
<tr>
<td>Modifying Skins</td>
<td>28</td>
</tr>
<tr>
<td>Enabling Languages</td>
<td>29</td>
</tr>
<tr>
<td>Configuring Multi-Language Search Results</td>
<td>29</td>
</tr>
<tr>
<td>Setting Default User Options</td>
<td>30</td>
</tr>
<tr>
<td>Configuring Default E-mail Text</td>
<td>30</td>
</tr>
<tr>
<td>Assigning a Root Topic</td>
<td>30</td>
</tr>
<tr>
<td>Adding a Content Set</td>
<td>32</td>
</tr>
<tr>
<td>Configuring the Site Home Page</td>
<td>32</td>
</tr>
<tr>
<td>Configuring Styles</td>
<td>32</td>
</tr>
<tr>
<td>Configuring Layout</td>
<td>33</td>
</tr>
<tr>
<td>Configuring Panels</td>
<td>33</td>
</tr>
<tr>
<td>Configuring the Search Page</td>
<td>33</td>
</tr>
<tr>
<td>Search Page Settings</td>
<td>34</td>
</tr>
<tr>
<td>Advanced Search Options</td>
<td>34</td>
</tr>
<tr>
<td>Set History Options</td>
<td>35</td>
</tr>
<tr>
<td>Configuring the Browse Page</td>
<td>35</td>
</tr>
<tr>
<td>Configuring the Solution Page</td>
<td>36</td>
</tr>
<tr>
<td>Configuring the Document Page</td>
<td>36</td>
</tr>
<tr>
<td>Configuring the Account Page</td>
<td>37</td>
</tr>
<tr>
<td>View Settings</td>
<td>37</td>
</tr>
<tr>
<td>Ticket Settings</td>
<td>37</td>
</tr>
<tr>
<td>Registration Field Settings</td>
<td>38</td>
</tr>
<tr>
<td>Configuring the Contact Us Page</td>
<td>38</td>
</tr>
<tr>
<td>Restoring Default Configurations</td>
<td>39</td>
</tr>
<tr>
<td>7 Targeting Events</td>
<td>43</td>
</tr>
<tr>
<td>Scenarios in ATG Self Service</td>
<td>43</td>
</tr>
<tr>
<td>Updating External Scenarios</td>
<td>43</td>
</tr>
<tr>
<td>Customizing Scenarios and Messaging</td>
<td>44</td>
</tr>
<tr>
<td>ATG Self Service Scenario Events</td>
<td>45</td>
</tr>
<tr>
<td>JMS Events</td>
<td>46</td>
</tr>
<tr>
<td>Targeting ATG Self Service Sites</td>
<td>46</td>
</tr>
<tr>
<td>Targeting Overview</td>
<td>47</td>
</tr>
<tr>
<td>Passing Parameters in a URL</td>
<td>47</td>
</tr>
<tr>
<td>Populating the Marketing Slot</td>
<td>48</td>
</tr>
<tr>
<td>8 Escalation and De-Escalation</td>
<td>51</td>
</tr>
<tr>
<td>About Escalation and De-Escalation</td>
<td>51</td>
</tr>
<tr>
<td>About Escalation</td>
<td>51</td>
</tr>
<tr>
<td>Enabling Escalation</td>
<td>52</td>
</tr>
</tbody>
</table>
## Contents

### 9 Advanced User Interface Configuration
- Configuring Escalation 52
- About De-Escalation 52
- Enabling De-Escalation 53
- Escalation and De-Escalation JMS Events 53

### 10 Adding ATG Self Service to an Existing Site
- Preparing User Interface Resources 56
- Customizing Page Layouts 57
  - Testing Application Customizations 58
  - Setting up Customization 58
- Displaying New Solution Classes 58
- Adding Custom Panels 59

### 11 ATG Self Service Reports
- Setting the Reporting Summary Service Schedule 68
- About ATG Self Service Reports 69
  - De-Escalation Reports 69

### Index
- 70
1 Introduction

This document covers ATG Self Service concepts and tasks that are performed by both site and system administrators.

Audience

This manual is intended for system administrators responsible for configuring ATG Self Service.

Documentation Conventions

The following conventions are used in this manual:

- Installation Directory
  
  `<ATG10dir>` — the directory where you installed ATG 10.0.2. For example, the default location for Windows installations is `C:/ATG/ATG10.0.2`.

- Menu Navigation
  
  The `>` (greater than) symbol indicates menu choices. For example, File > Save means you should select the Save option on the File menu.

For information on the supported environments and configurations of the entire ATG product suite, see http://www.atg.com/en/products-services/commerce/supported-environments/.

Related Documents

<table>
<thead>
<tr>
<th>Document</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ATG Business Control Center User’s Guide</td>
<td>Describes how to use the ATG Business Control Center to create and manage Web site assets for ATG Content Administration. Intended for content developers and editors.</td>
</tr>
</tbody>
</table>
Before You Begin

This section provides a high-level description of the tasks you need to perform before running ATG Service Administration and deploying settings from ATG Service Administration to ATG Knowledge and ATG Self Service:

1. Install a supported application server. Consult the ATG Installation and Configuration Guide for information on your application server.
2. Install ATG 10.0.2. Consult the ATG Installation and Configuration Guide for your application server.

3. Install ATG Service.

4. Configure ATG Knowledge (if necessary) and ATG Self Service data sources as outlined in the ATG Service Installation and Configuration Guide.

Browser and Environment Requirements

For information about the supported browsers, environments, and configurations, see http://www.atg.com/en/products/architecture/requirements/.

Cookies and scripting should be enabled in the browser used to access ATG Service Administration.
2 Configuring ATG Self Service Overview

ATG Self Service requires the PublishingAgent module, which is included as part of the ATG Adaptive Scenario Engine. ATG Self Service also requires a separate instance of the PublishingWebAgent module, which is part of the ATG Web Server Extensions.

**Important:** Consult the ATG Installation and Configuration Guide for your application server for detailed information on the following application server-specific tasks that must be complete before installing ATG Self Service:

- Installing the ATG platform
- Configuring your environment

Starting ATG Self Service

It is best to run the production SelfServiceDataWarehouse module in a separate JVM instance than your ATG Self Service server. Depending on the volume of reporting data to be summarized, you may want to dedicate one instance to an application that contains only the SelfServiceDataWarehouse module.

It is also possible to configure the SelfServiceDataWarehouse module to work in the same JVM as your ATG Self Service Server.

The last two steps in this procedure specify modules to include in the Web application you build. For guidance on assembling applications, see the ATG Installation and Configuration Guide for your application server.

To run the ATG Self Service application in one JVM and run an ATG Self Service application or service.common and ATG Self Service DataWarehouse in another JVM:

1. Configure each server’s properties to use same the same database by modifying the FakeXADatasource.properties file.
2. Disable user sessions for the second server. Refer to the ATG Installation and Configuration Guide for further information. (Skip this step if you are configuring a service.common and ATG Self Service Data Warehouse JVM.)
3. Configure the lock manager by configuring one or more of your servers to start the /atg/dynamo/service/ServerLockManager at application startup. Modify the
4. Configure the ClientLockManager component in the
<ATG10dir>/home/servers/svcadmin/localconfig/atg/dynamo/service/
ClientLockManager.properties file for both servers to use the
ServerLockManager:

   $class=atg.service.lockmanager.ClientLockManager
   lockServerAddress=12.3.4.500
   lockServerPort=9010
   useLockServer=true

Refer to the ATG Repository Guide for additional information.

5. Assemble, deploy, and start an ATG Self Service application that includes the
Service.SelfService module as outlined in the ATG Service Installation and
Configuration Guide

6. Assemble, deploy, and start an ATG Self Service Data Warehouse application that
includes the Service.SelfServiceDataWarehouse module as outlined in the ATG
Service Installation and Configuration Guide.

ATG Self Service Sites

ATG Commerce provides multisite functionality that can present separate Web sites to serve different
purposes for your users. For example, you might configure a site for users in a particular country or for
users with a specific requirements or interests. ATG Commerce includes ATG Self Service and you can
configure multiple ATG Self Service sites.

Configure sites to control the way that users will experience ATG Self Service. A site acts like a channel
through which users can interact with your ATG Self Service installation. You can create multiple ATG Self
Service sites as required by the organization of your other Web resources and the needs of your users.

Sites are used to control user experience by many other ATG Commerce applications. See more
information about sites and how to configure them in the ATG Multisite Administration Guide.

Use sites to provide different experiences to groups of ATG Self Service users. Site configurations affect:

- The topics available when ATG Self Service users browse solutions or filter search
  results
- The appearance of the ATG Self Service user interface
- Languages used
• User interface behavior
• Contact information for your organization

Sites allow ATG Self Service to separately provide different types of content.

**Note:** ATG Commerce also uses user segments to provide different user experiences to groups of site visitors. Use multiple sites to present different sets of content to visitors. Use segments to customize a site for specific types of visitors. See Identifying User Segments.

**The Default ATG Self Service Site**

ATG Self Service is configured with one site by default. If you do not configure any other sites, this default site controls the user experience of your site visitors.

If you use the default site as an actual ATG Self Service site, you will not be able to use all of the configuration options that are available for a site that you create. See information about creating sites in the ATG Multisite Administration Guide.

**Site Settings Hierarchy**

You can apply configuration settings to ATG Self Service in several ways depending on the level of flexibility that you need. You can apply settings once and have them affect all your sites and user segments or you can apply different settings for each site and segment.

ATG Self Service sites follow a hierarchy of settings levels. If a configuration option is not set at one level, a site will take the setting from the next level. The order in which sites look for configuration settings is shown below.

1. Settings specific to an external user segment. See Sites and External User Segments.
2. Settings specific to the site. When you add an ATG Self Service site to your installation, it will appear in the Self Service menu of the Service Admin application.

3. Settings for the default ATG Self Service site. See Sites Inherit Settings from the Default Site.

4. Settings configured in the Global Settings section of the Service Admin application.

Sites and External User Segments

Associate external user segments with ATG Self Service sites to personalize the user experience those sites provide. External user segments identify groups of site visitors. In the Service Admin application you can choose to make configurations that apply to an entire ATG Self Service site or to a specific external user segment.

User segments are a component of the personalization configurations used by all ATG Commerce applications. See basic information about segments and instructions for using them in the ATG Knowledge Guide for Business Users.

![Make configurations for a specific external user segment or for an entire site.](image)

If you have created an ATG Self Service site and you have associated an external user segment with that site, you can make site configurations that will apply only to that user segment. To make site configurations that are specific to an external user segment:

1. Make sure the ATG Self Service site is created and that the external user segment is associated with it.
   See information about creating external user segments in the ATG Business Control Center User’s Guide. See instructions for associating an external user segment with an ATG Self Service site in Adding External User Segments to a Site.

2. Choose a segment from the menu at the top of the ATG Self Service configuration pages.

3. Make configurations on the page and save your changes.

4. Select another segment from the menu to continue making segment-specific configurations or choose the site name from the menu to make changes that will affect all site visitors.

Note: You cannot associate external user segments with the default ATG Self Service site. If you need to personalize an ATG Self Service site by user segment, create a site. See instructions in the ATG Multisite Administration Guide.
Note: ATG Self Service also uses external user segments to restrict access to solutions by site. See information about solution access in Controlling Solution Access at Sites.

Sites Inherit Settings from the Default Site

The ATG Self Service sites that you configure inherit configurations from the default site. Any configurations that you make to the default site also apply to the other sites. If you override a setting for one of the sites you configure, the configuration of the default site will no longer affect that setting for the site.

The following diagram shows the Service Admin application interface. It contains controls for configuring the default ATG Self Service site and two example sites that have been created in the Site Administration utility. The Site Administration utility is in the BCC. Configurations that you make for the default site (marked 1 in the diagram) apply to the other sites (marked 2 in the diagram) unless those sites explicitly override a default setting.

Configurations made for the default site (1) are inherited by the other ATG Self Service sites (2).

Use site configuration inheritance to help manage multiple ATG Self Service sites. If you want your sites to share certain configurations, make them at the default site and allow the other sites to inherit them.
3 Configuring Solutions

After you have started the ATG Self Service application and ATG Search server, perform the following steps to configure solutions.

Deploying Solution Attachments

Solutions can include images or other documents in any statement field of the solution. See the ATG Knowledge Guide for Business Users for more details. Under certain circumstances, you must configure ATG Knowledge and ATG Self Service so that they can locate these attachments correctly.

If you have any of the following ATG configurations, you must configure your servers before they can deploy attachments correctly:

- if you are using a third party application server
- if your ATG Content Administration server uses a context root for ATG Service applications other than /svc
- if you have another J2EE application running on the same server with a context root of /svc
- if you want to use a non-default location for attachments for any other reason

Several steps in this procedure include URLs that begin with variables: hostname refers to the name of the machine running your application server and port refers to the port number that application server uses to listen for HTTP requests. For default port information, see the ATG Installation and Configuration Guide for information on your application server.

To configure attachment settings on your ATG Self Service server:

1. Configure your ATG Self Service server so that the top-level directory for your documents and images (by default, /svc) is served from the local file system.


3. Ensure that the Site URL field contains the name of your site.

If you have more than one ATG Self Service site, enter the URL of the default site in this field. See The Default ATG Self Service Site.
4. Make sure your server can deploy to the `/atg/epub/file/WWWFileSystem` directory:

   Launch the BCC (http://hostname:port/atg/bcc).

   In the left-hand pane, go to Business Control Center > Content Administration > Admin Console > Configuration.

   Use the right-hand pane to select the name of your ATG Self Service server. In the screen that appears, click on Agents.

   Below the Agent Name, make sure `/atg/epub/file/WWWFileSystem` appears in the Destinations area. If it does not appear, click on the agent name to add this directory to the list of Destinations and save changes.

5. Use the ACC to open the `/atg/svc/repository/service/util/AttachmentUtils` component.

6. Change the value of the `documentRootFolder` attribute from `/svc/documents` to the name of the directory you wish to use.

7. Change the value of the `imageRootFolder` attribute from `/svc/images` to the name of the directory you wish to use.

8. Open the `/atg/svc/email/emailLandingPage` component. The default value of the `EmailLandingPage` attribute is `main.jsp`. However, if the `siteIDToBrandMap` component is defined, the brand value will be appended as the brand parameter to the default Self Service base URL.

   **Note:** The setting in the `emailLandingPage` will only be used if the `productionUrl` is not defined in the BCC.

9. Save the changes to the live state, and start the component.

   **Note:** In order for your changes to take affect, you need to re-assemble, redeploy, and restart your application. For application assembly instructions, see the ATG Installation and Configuration Guide.

### Creating Problem Categories and Assigning Ticket Queues

When ATG Self Service users contact support, they can select a problem category for their issue. These categories are associated with ticket queues so that the ticket that is created is automatically assigned.

**Note:** Be sure you have already created ticket queues to associate with the problem categories. See the ATG Ticketing Guide for Business Users for more information on ticket queues.

To create problem categories for ATG Self Service:

1. On the ATG Self Service server, open the ACC and navigate to Content > LogicalOrganizations.

2. List items of type ProblemCategory.

3. Click New Item.

4. Select and edit the `logicalOrganization` property.
5. List items of type Ticket Queue. Choose one and click OK.
6. Enter a name for the new problem category and click OK.

Configuring Hot Solutions, Top Questions, and Best Bets

The Hot Solutions, Top Questions, and Best Bets panels keep track of popular solutions. These solution lists are defined in the built-in Solution Lists topic set in ATG Search. Topic sets are hierarchical organizations of content items that help users search or browse content. Rule patterns and macros allow you to automatically associate your content with topics.

When you configure the following, the `create-atgservice-searchproject` script automatically creates and populates the Solution Lists topic set:

- Configure the ATG Search environment as described in the “Configuring Search Environment” section in the ATG Service Installation and Configuration Guide.
- Configure the `remoteHost` and `remotePort` numbers on the Search server as described in the “Configuring Remote Host Information” section in the ATG Service Installation and Configuration Guide.

For more information about topic sets, see the ATG Search Administration Guide.

Configuring Hot Solutions

Hot Solutions are identified when a `hotScore` is associated with the solution. The `hotScore` is rated according to the following formula:

\[
\text{hotScore} = (\text{useCountWeight} \times \text{hotUseCount}) + (\text{viewCountWeight} \times \text{viewCount})
\]

- `useCountWeight` is provided using the admin option specified in the `AgentHSUseCountWeight` site option.
- `hotUseCount` is the `useCount` property on the solution and is incremented every time a solution is linked to a ticket.
- `viewCountWeight` is provided using the admin option specified in the `AgentHsviCountWeight` site option.
- `viewCount` is the `viewCount` property on the solution and is incremented every time a solution is viewed.

To configure the hot solutions panel:

1. Open the BCC > Service Admin > Service Admin Configuration > Service Project > Service Center > Global Service Center Settings > Helpful Panels page.
2. Configure the number of solutions to display. Users can override this default in their preferences.
3. Set the default topics that appear in the Hot Solutions panel. You can select All Topics or select from the list of available topics. Users can override this default in their preferences.

Note: The Best Bets list is the same as the Hot Solutions list, but is restricted to solutions also marked as best bets.

Setting the Maximum Number of Solutions to Display

To set the maximum number of solutions to display in the Hot Solutions, Top Questions, and Best Bets panels on your ATG Self Service sites’ home pages, see Configuring Panels.

Running ATG Self Service on a Production Environment

For information on running ATG Self Service and ATG Knowledge together in a production (or customer-facing) environment see the ATG Knowledge Configuration Guide.

You must run ATG Self Service on an ATG instance that is accessed by external users. This instance must have the following characteristics:

- It must run your customer-facing web applications.
- Any commerce-related items (catalogs and price lists) are read-only; therefore you can keep them synchronized across ATG instances by periodically publishing the current data to all instances simultaneously. For the order repository, however, the data is constantly being modified by customers, so all ATG instances must point to the same set of database tables.
- You should run a separate ATG instance that has ATG Service Administration and ATG Content Administration running together.
4 Identifying User Segments

When you define a user segment, you are defining a target audience. ATG Self Service uses user segments to:

- Set field security on global fields. Refer to the ATG Service Installation and Configuration Guide for information on configuring security on global fields
- Set list value security on list field values. Refer to the ATG Service Installation and Configuration Guide for information on configuring security on list values
- Set value security on the intrinsic fields Owning Group, Internal Audience, and External Audience. Refer to the ATG Service Installation and Configuration Guide for information on configuring security on intrinsic fields
- Identify targeted content displayed on ATG Self Service sites

For information on creating user segments, refer to the ATG Business Control Center Administration and Development Guide.

Note: Anonymous users default to “female.” When creating a segment that looks for female users, anonymous users will be included in the segment.

Note: You can also create multiple ATG Self Service sites to provide separate user experiences for site visitors. If you need to present separate ATG Self Service sites, see Creating an ATG Self Service Site.

Prerequisites

Create segments before adding them to your ATG Self Service sites. Refer to the ATG Business Control Center Administration and Development Guide for information on creating user segments.

Note: When you create external user segments for Service, you must create them on the management server BCC. External user segments cannot be created on the agent server BCC.

Selecting User Segments

You can choose which external user segments are available for use in configuring ATG Self Service. By default, all the external user segments that you create in the BCC running on your asset management server are available. Selecting specific segments will limit the list of segments.
To select specific external user segments for configuring ATG Self Service:

1. Log in to the BCC running on your agent server.
2. Choose Service Admin > Service Admin Configuration > Project Name > Service User Segments panel.
3. Choose Service User Segments from the Admin Options menu.
4. Select the Select Specific radio button in the Self Service User Segments section of the Service User Segments screen.
5. Click Add Self Service Segment to display the Add Self Service User Segment screen window.
6. Select the external user segments that you want to use with ATG Self Service.

For information on creating user segments, refer to the ATG Business Control Center Administration and Development Guide.

Ordering Segments

The order of segments is important, because a user may be a member of more than one segment. A user will see the look and feel that is defined for the first segment in this list of which they are a member.

To reorder segments:

1. Log in to the BCC running on your agent server.
2. Choose Service Admin > Service Admin Configuration > Project Name > Self Service.
3. Choose the site for which you want to order segments from the Admin Options menu.
4. Click the up or down arrows to move a segment in the list.

Removing Segments

You can remove any segment by clicking the remove icon next to the segment name. An “Are you sure?” message will appear and you can either cancel the operation or click OK to remove the segment.
### Identifying User Segments

<table>
<thead>
<tr>
<th>Segments</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>MusicSelfServiceSiteVisitors</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RegisteredUsers</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
4 - Identifying User Segments
5 ATG Self Service Global Settings

You can configure settings that affect all sites defined in your installation by using the Global Settings page within the BCC.

Configuring Anonymous User Access

You can configure anonymous access to ATG Self Service sites.

1. Open the BCC and select Service Administration > Self Service > Global Settings.
2. Select the check box to Allow Anonymous Users access to the site.
3. Select the check box to have each segment site require a separate login per user.

Note: When you create an anonymous user, the default sex for the user is female. If you create a segment for female customers, anonymous users will be included in the segment.

Filtering Cookies

Platform for Privacy Preferences (P3P) functionality provides advanced cookie filtering. Cookie filtering evaluates a Web site's privacy practices and decides whether the cookie is acceptable.

P3P is the privacy policy declaration that is inserted in the header response by the HTTP server. It is required by Microsoft’s Internet Explorer (IE) browser, and if the Web server does not declare it, depending on the security settings, the page might not load.

1. Open the BCC > Service Admin > Service Admin Configuration > Project Name > Self Service > Global Settings.
2. Using the P3P panel, select the Policy Enabled check box to enable cookie filtering.
3. Enter the file path for the location of your P3P policy in the Policy File Path field.
4. Enter the Compact Policy Value. The Compact Policy is required by IE 6.0 + and other browsers for all third-party framed sites to be able to set cookies, call JavaScript functions, and so on.

The following is an example of what you might enter in this field:
Configuring Site Information

You can configure site information, including the Site Administrator's e-mail address and the addresses of the ATG Self Server and the PublishingWebAgent:

1. Open the BCC > Service Admin > Service Admin Configuration > Project Name > Self Service > Global Settings.
2. Scroll to the Site Management panel.
3. Enter the site administrator's fully qualified e-mail address. For example: siteadmin@catalog.com
   Enter the address of your ATG Self Service site. For example: https://server2.catalog.com:8550.
   If you have more than one ATG Self Service site, enter the URL used by the default ATG Self Service site. See The Default ATG Self Service Site.
4. Enter the address of the PublishingWebAgent for your default ATG Self Service site. This must be the full URL without an ending slash, for example: https://server2.catalog.com:8550/fall/graphics. See The Default ATG Self Service Site.

   This option is used to format the URLs sent inside e-mails and when displaying images and attachments on your ATG Self Service sites.

Site Landing Page

You can designate a site landing page that is used during e-mail link routing. Site visitors are redirected to the landing page identified in their profile so that they see the correct content.

1. Open the BCC > Service Admin > Service Admin Configuration > Project Name > Self Service > Global Settings.
2. Scroll to the Site Landing Page panel. Select the check box to Allow Site Landing Page.
3. Specify the application path to the landing page in the Site Landing Page Path field. The default is /siteLandingPage.jsp.

   Note: If you were using Brand Management in earlier versions of Self Service, the Site Landing Page Path should remain as /brandSelection.jsp.
6 Configuring an ATG Self Service Site

You can configure the look and feel of an ATG Self Service site, as well as identify a number of differently displayed options.

Creating an ATG Self Service Site

Create an ATG Self Service site in the Site Administration utility. The Site Administration utility is in the BCC running on your asset manager server. After you create a site with its site type set to Self Service, it will appear in the Self Service section of the Service Administration application menu. The site will be available to users according to the way you configure the URL for the site.

See information about creating and configuring sites in ATG Multisite Administration Guide.

Copying Site Settings

You can copy all site configurations from one ATG Self Service site to another.

To copy site settings:

1. Log in to the BCC running on your agent server.
2. Choose Service Admin > Service Admin Configuration > Project Name > Self Service.
3. Choose the site that the copied settings will apply to from the Admin Options menu.
4. Click the Copy settings from button. Choose the site from which you want to copy configurations in the Copy Settings From window and click OK.
5. Deploy the project.

Adding External User Segments to a Site

You can personalize ATG Self Service sites based on the external user segment of site visitors. See Sites and External User Segments.

To add an external user segment to an ATG Self Service site:
1. Log in to the BCC running on your agent server.

2. Choose Service Admin > Service Admin Configuration > Project Name > Self Service.

3. Choose the site to which you want to add an external user segment from the Admin Options menu.

4. Click the Add Segments button. Choose the segments you want to add from the Add Segment window and click OK.

5. Deploy the project.

Note: if the external user segments you want to add are not shown in the Add Segment window, you may need to make them available to ATG Self Service. See Selecting User Segments.

Controlling Solution Access at Sites

Restrict the solutions that are available at an ATG Self Service site using external user segments. Solutions have an external audience property that controls which external user segments can view them in ATG Self Service.

To control which solutions are available at an ATG Self Service site:

1. Configure external user segments that include only visitors to a specific site. See Creating a Site-Specific External User Segment.

2. Include that external user segment in the external audience property of the solutions for the site. See instructions in the ATG Knowledge Guide for Business Users.
Site-specific segments match the external audience of solutions (1). Other solutions are not available (2).

**Note:** the segment shown in this diagram has been created specifically for the site it is associated with. However, the site and segment are separate entities.

**Creating a Site-Specific External User Segment**

Segments are groups of visitors to an ATG Web site. ATG Commerce software uses segments to customize user experiences for those groups. You can identify segments based on many characteristics of Web site visitors. For example, you could create a segment that includes visitors who have registered with your Web site and created user profiles.

Site-specific external user segments are segments that include only the visitors to a particular ATG Self Service site. Use site-specific segments if you need to apply a segment configuration to a particular ATG Self Service site.

User segments are a component of the personalization configurations used by all ATG Commerce applications. See basic information about segments and instructions for using them in the *ATG Business Control Center User’s Guide*.

To create a site-specific external user segment for controlling solution access in ATG Self Service:

1. Add an external user segment in the Targeting and Segmentation interface of the BCC running on your asset management server. See instructions in the *ATG Business Control Center User’s Guide*.
2. Insert an exclude action in the default rule of the segment. Configure the action to exclude everyone.
3. Add an override rule to the segment. Choose the site name from the control labeled “executes on.”
4. Insert an include action in the override rule. Configure the action to include everyone.
5. Save the segment and deploy it.

Unstructured Content and Sites

You can restrict unstructured content to specific ATG Self Service sites using the Sites Meta Tag function of ATG Search indexing. Unstructured content is information in file system resources such as HTML, PDF, or similar files.

Choose the sites that you want to have access to unstructured content in the Sites Meta Tag control in the ATG Search Administration application. See information about the Sites Meta Tag and ATG Search indexing in the ATG Search Administration Guide.

Selecting a Site Skin

Skins are a way to provide branding and navigation for ATG Self Service. The skin provides the entire HTML surrounding the current view.

- Skins use a SkinDefinition item descriptor to provide the data for the index.jsp page.
- The index.jsp page uses the style attribute as the name of a SelfServiceSiteOption that is included in the <head> section.
- The index.jsp page uses the javascript attribute as the name of a SelfServiceSiteOption that is included in the <head> section.
- The index.jsp page uses the layoutUrl attribute to include the skin in the <body> section. The layoutUrl is included using a <jsp:include> tag.
- The skin may define additional options using the additionalOptions attribute. The Skin Settings page in Service Admin uses the hint attribute of the SelfServiceSiteOption to determine which editor to place in the page. Valid values for hint are: null, int, string, longstring, and Boolean.
- The skin JSP page should include the view.jsp page to render the actual view.
- The skin needs to provide navigation for the application. The skin should have access to an object that lists all the currently available views.

The skin author is responsible for providing the JSP page to be rendered, defining the SkinDefinition instance in the repository, and setting up the SelfServiceSiteOptions in the repository. The skin author must create at least a SelfServiceSiteOption for style and a SelfServiceSiteOption for javascript, even if the default value is empty. The skin author can define additional options that are used by the skin and these should be created in the repository.

Authoring a skin is a developer task. Configuring the SelfServiceSiteOptions for a skin should be done in the Service Admin > Skin Settings page.
Default Skins

ATG Self Service comes with skins that you can choose to customize your site or a segment within a site.

Simple Links Skin

- This skin contains a list of the currently available views from the Global Navigation List separated by a vertical bar. The current view is highlighted.
- The logo image is optional. If not required, the space for it is removed.
- If the current view is solution, document, or advisor then the view name is shown between Browse and My Account. Otherwise, the view name for solution, document, or advisor is removed.

Simple Tabs Skin

- This skin contains a list of the currently available views from the Global Navigation List inside tabs. The current view is highlighted.
- The logo image is optional. If not required, the space for it is removed.
- If the current view is solution, document or advisor then the view name is shown between Browse and My Account. Otherwise, the view name for solution, document, or advisor is removed.

HTML Skin

- This skin is has sections for HTML to be displayed at the head, foot, left and right of the view. It contains a list of the currently available views from the Global Navigation List inside tabs. The current view is highlighted.
- If the current view is solution, document or advisor then the view name is shown between Browse and My Account. Otherwise, the view name for solution, document, or advisor is removed.

Original Skin

- This skin provides a browse tree panel on the home page and changes the default layout to match the original appearance of ATG Self Service.

To select the skin for an ATG Self Service site:

1. Log in to the BCC running on your agent server.
2. Choose Service Admin > Service Admin Configuration > Project Name > Self Service > Site Name > Skin Settings.
3. Select the skin you want to apply to the site. Save your changes and deploy the project.

Modifying Skins

To edit the skin that you have selected for an ATG Self Service site:

1. Log in to the BCC running on your agent server.
2. Choose Service Admin > Service Admin Configuration > Project Name > Self Service > Site Name > Skin Settings.

3. Edit the Skin CSS and Skin JavaScript fields as needed. Select or deselect the logo placeholder if you are using the Simple Tabs skin.

4. Save your changes and deploy the project.

**Note:** if you modify any of the skin settings on the Skin Settings page, you will override all the other settings also. The Service Admin application will no longer update the skin settings for your site if the corresponding settings for the default site are changed.

### Enabling Languages

You can set the available and default languages used in search queries and results.

To set the language:

1. Open the BCC > Service Admin > Service Admin Configuration > Project Name > Self Service > Site Name > General Settings.

2. Select the languages to enable.

3. Select the language to use as the default language.

4. In order to determine what languages to use, by default, ATG Self Service checks the user options in the user profile for a given user. If these are turned on, it uses these for query and results language settings.

5. If User Options are not set, then the Use Browser’s locale (if supported) is checked.

6. Save your settings.

### Configuring Multi-Language Search Results

When working in multi-language environments, some browsers cannot display the correct search results because they contain characters that cannot be read by HTML. To identify and filter any characters that the browser cannot display, and to allow the search results to display the text, perform the following steps:

1. Open the ACC > Pages and Components > Components by Path section.

2. Locate and open the /atg/svc/self/ui/SelfServiceUIConfiguration component. Set the isEnableControlCharacterFilteringForSearchResultTitles property to ON. This will filter out the characters that cannot be read by HTML in the search results. By default this property is set to OFF.

**Note:** This property can be turned off if you notice performance issues in the future.
Setting Default User Options

These settings allow you to enable or disable the default forms for customer login, registration and profile edits, as well as password changes:

1. Open the BCC > Service Admin > Service Admin Configuration > Project Name > Self Service > Site Name > General Settings.

2. Select the default forms to use. If you disable any of these settings, you can provide alternate URLs for your own custom forms. You can use ATG Self Service pages to manage your customers' information and behavior or use another location on your Web site.

3. Save your settings.

Note: Make sure that the user registration options for ATG Self Service are compatible with user registration options you have configured for other ATG Web sites. For example, if you use the ATG Commerce Reference Store along with ATG Self Service, you must customize the ATG Self Service user registration page so that a user’s email address is used as the login value.

Configuring Default E-mail Text

These settings allow you to specify default HTML code for the e-mails sent to ATG Self Service users.

1. Open the BCC > Service Admin > Service Admin Configuration > Project Name > Self Service > Site Name > E-mail Settings.

2. Enter any HTML for the E-mail Header, E-mail Footer, Forgotten Password E-mail Preamble, Registration E-mail Preamble, or E-mail -a-friend E-Mail Preamble. Ensure that the code in these fields is correct HTML.

3. Save your changes.

Assigning a Root Topic

The root topics for an ATG Self Service site are the solution topics that users can choose when they open the browse function or focus search results by topic. Users can then expand the root topics to choose from the subtopics that they contain.

You can choose more than one root topic for an ATG Self Service site. If you are presenting more than one type of information, you can offer site visitors root topics for each one. For example, you might present a root topic containing information about customers’ accounts and also a root topic containing information about the products available from a commerce Web site.

You can also use multiple root topics to offer localized languages to your site visitors. ATG Self Service will selectively display topics according to the language configurations you make. You can configure rules for your site that will display a topic only if a visitor’s browser language settings or registered language preferences meet specific criteria. For example, you might translate your solutions into the English and...
French languages. Then if you add both an English root topic and a French root topic to your site, ATG Self Service will display only one root topic, based on the language rule you configured. A visitor who prefers using the French language would see only the French root topic. See Enabling Languages.

The root topics of a site do not limit the solutions that are available using the search function of ATG Self Service. See information about security configurations for solutions in the ATG Service Installation and Configuration Guide.

To assign root topics to an ATG Self Service site:

1. Open the BCC > Service Admin > Service Admin Configuration > Project Name > Self Service > Site Name > Root Topic Assignment Page.
   If needed, choose the external user segment that this configuration will apply to. See Sites and External User Segments.
2. Select the Selected Root Topics radio button.
3. Select the checkboxes for each root topic you want to display in the ATG Self Service site. If you select a parent topic, all of its child topics are also included in the site. See the diagrams following this procedure.
4. Click the Save button. Review and deploy the configuration project.

The following diagrams show root topic selections from different points in the topic hierarchy.

```
  ▼ Trees
    □ Deciduous
    □ Evergreen
  ▼ Seasons
    □ Winter
    □ Summer
```

Selecting a parent topic also includes its child topics on the site.

```
  □ Trees
    △ Deciduous
    □ Evergreen
  □ Seasons
    □ Winter
    □ Summer
```

You can select specific child topics as the root topics for a site.
Adding a Content Set

A content set is a portion of an ATG Search project. Add a content set to an ATG Self Service site if you want site users to be able to search for the information in that content set. See information about content sets in the ATG Search Administration Guide.

To add a content set to an ATG Self Service site:

1. Make sure the content set does not share a content label with any other content set for the site. You can add only one content set per content label. Add a new content label to your search project and assign it to the content set if needed. See the ATG Search Administration Guide.

2. Edit the site in the Site Administration utility. The Site Administration utility is in the BCC that is running on your asset management server. See the ATG Multisite Administration Guide.

3. Find the content label in the Search Content control in the Site section of the Site Administration user interface. Choose the content set in the Content Set menu for that content label.

4. Save and deploy your project.

Configuring the Site Home Page

The Home Page settings allow you to specify styles, layout, and panel configuration for the site.

Configuring Styles

You can choose to use an external or internal cascading style sheet (CSS).

1. Open the BCC > Service Admin > Service Admin Configuration > Project Name > Self Service > Site Name > Home Page > Styles.

2. If you select External, you can specify a URL for your CSS.

3. If you select Internal, the default CSS is displayed in a text editor where you can modify it if desired.

For example:
Configuring Layout
You can specify the number of columns to use on the ATG Self Service home page and which panels to display in each column.

1. Open the BCC > Service Admin > Service Admin Configuration > Project Name > Self Service > Site Name > Home Page > Layout.
2. Select one, two, or three columns.
3. Select a panel.
4. Order the panels as you require. Once you have added panels to a column, you can reorder them or delete them from the column.
5. Save your settings.

Configuring Panels
This page allows you to specify settings for various panels in ATG Self Service.

1. Open the BCC > Service Admin > Service Admin Configuration > Project Name > Self Service > Site Name > Home Page > Panels.
2. Enter a number that specifies the maximum number of solutions or questions to display in the Hot Solutions, Best Bets, and Top Questions panels.
3. Save your settings.

Configuring the Search Page
This page allows you to specify the search behavior on ATG Self Service on a per-site basis.
Search Page Settings

1. Open the BCC > Service Admin > Service Admin Configuration > Project Name > Self Service > Site Name > Search Page.

2. To enable search, select the Allow Search checkbox.

3. You can set an external or an internal CSS. If you set an internal CSS, provide the CSS code in the CSS box.

4. Select Show Example Questions radio buttons to show example questions always, once, or never to users.

5. You can Rotate Questions by either specifying an exact number of seconds or choosing to change the questions when the user refreshes the page in her browser.

6. Enter the number of search results to display on a page in the Num Results field.

7. Enter the maximum number of search results to return in the Max Number of Results field.

8. You can set the default method for sorting results from the list of Score, Date Modified, Document Format, and Title using the Default Sorting drop down menu.

9. Set the following check boxes to enable these features:
   - Allow User Sorting - Specifies whether users can sort their results.
   - Allow Sorting by Date Modified - Specifies if the user can sort using Date Modified.
   - Show Rate these results - Specifies whether to show the “Rate these Results” form to users.
   - User Filter by Topic - Specifies whether users can filter their results by topic.

Advanced Search Options

You can make changes to the Advanced Search Options by modifying the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use advanced options</td>
<td>Specifies whether or not users can search using the advanced search criteria.</td>
</tr>
<tr>
<td>Advanced search open by default</td>
<td>Specifies whether or not the advanced search feature is open by default when the user goes to the Search page.</td>
</tr>
<tr>
<td>Show Language selection</td>
<td>Specifies whether or not users can select query and results languages.</td>
</tr>
<tr>
<td>Document Formats</td>
<td>Checking this box to allows users to filter their searches by document format.</td>
</tr>
<tr>
<td>Enable Formats</td>
<td>Selects each file type by which users can filter their searches.</td>
</tr>
</tbody>
</table>
Set History Options

You can enable the display of histories within Search by selecting the Display History checkbox. When histories are enabled, they can be opened by default. The following settings are available with the History Option:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>History open by default</td>
<td>When checked, opens the history view by default.</td>
</tr>
<tr>
<td>Max number of stored searches</td>
<td>Specifies the number of stored searches that are available.</td>
</tr>
<tr>
<td>Your Last Visit: Search History Max</td>
<td>Specifies the maximum number of searches that are stored from the user's last visit.</td>
</tr>
<tr>
<td>Your Last Visit: Answers History Max</td>
<td>Specifies the maximum number of answers that are stored from the user's last visit.</td>
</tr>
<tr>
<td>Your Recent Activity: Search History Max</td>
<td>Identifies the number of maximum searches stored during the user's current session.</td>
</tr>
<tr>
<td>Your Recent Activity: Answers Viewed Max</td>
<td>Identifies the number of maximum answers stored during the user's current session.</td>
</tr>
</tbody>
</table>

Configuring the Browse Page

This page allows you to specify the browse behavior on an ATG Self Service site.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Browse</td>
<td>Check this box to allow users to browse the topic tree.</td>
</tr>
<tr>
<td>Use CSS</td>
<td>Selects an external or internal CSS for the browse page.</td>
</tr>
<tr>
<td>Num Results per page</td>
<td>Enters a number for how many results to display on a page.</td>
</tr>
<tr>
<td>Max Number of results</td>
<td>Specifies the maximum number of results.</td>
</tr>
<tr>
<td>Default Sorting</td>
<td>Selects the default method for sorting results from the list of Use Count, Date Modified, or Title.</td>
</tr>
<tr>
<td>Allow User Sorting</td>
<td>Specifies whether users can sort their results.</td>
</tr>
<tr>
<td>Show Topics if Empty</td>
<td>Specifies whether or not to display in the topic tree topics that contain no documents or solutions.</td>
</tr>
</tbody>
</table>
### Configuring the Solution Page

This page allows you to specify the display of solutions on an ATG Self Service site.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use CSS</td>
<td>The external or internal CSS for the solution page.</td>
</tr>
<tr>
<td>Allow Ratings</td>
<td>Specifies whether or not users can rate a solution.</td>
</tr>
<tr>
<td>Show Metadata</td>
<td>Identifies whether or not to display the solution’s metadata to ATG Self Service users. Solution metadata includes the solution ID, created and modified dates, solution language, and Best Bet status.</td>
</tr>
<tr>
<td>Allow E-mail a friend</td>
<td>Identifies whether or not users can e-mail a solution to someone else.</td>
</tr>
<tr>
<td>Allow Print</td>
<td>Specifies whether or not users can print a solution.</td>
</tr>
<tr>
<td>Allow Escalate</td>
<td>Specifies whether or not a user to can escalate her problem directly from the solution page by displaying the “Need More Help?” link there.</td>
</tr>
<tr>
<td>Print Header HTML</td>
<td>Identifies HTML code for the solution header when printing.</td>
</tr>
<tr>
<td>Print Footer HTML</td>
<td>Identifies HTML code for the solution footer when printing.</td>
</tr>
</tbody>
</table>

**Note:** When running on a Solid or DB2 database, to view Japanese characters correctly when the solution is authored in Japanese, use the BCC to set the `useSetCharacterStream` attribute to `true` in the `/atg/service/common/src/config/atg/svc/ServiceRepository` component. You can set the value for all repositories in your ATG installation by editing the `GLOBAL.properties` file in the top-level configuration layer.

### Configuring the Document Page

This page is used to specify the display of documents (unstructured content) on an ATG Self Service site.
### Setting Description

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use CSS</strong></td>
<td>Selects an external or internal CSS for the document page.</td>
</tr>
<tr>
<td><strong>Allow Ratings</strong></td>
<td>Specifies whether or not users can rate a document.</td>
</tr>
<tr>
<td><strong>Show Metadata</strong></td>
<td>Selects whether or not to display the document’s metadata to ATG Self Service users. Document metadata includes type and size.</td>
</tr>
<tr>
<td><strong>Allow E-mail a friend</strong></td>
<td>Specifies whether or not users can e-mail a document to someone else.</td>
</tr>
<tr>
<td><strong>Allow Print</strong></td>
<td>Specifies whether or not users can print a document.</td>
</tr>
<tr>
<td><strong>Allow Escalate</strong></td>
<td>Specifies whether or not a user to can escalate her problem directly from the document page by displaying the “Need More Help?” link there.</td>
</tr>
</tbody>
</table>

### Configuring the Account Page

This page allows you to specify the display of documents (unstructured content) on an ATG Self Service site.

#### View Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use CSS</strong></td>
<td>You select an external or internal CSS for the document page.</td>
</tr>
<tr>
<td><strong>Show Tickets</strong></td>
<td>You specify whether or not to display the My Tickets panel on the Account page.</td>
</tr>
<tr>
<td><strong>Show History</strong></td>
<td>You specify whether or not to display the My History panel on the Account page.</td>
</tr>
<tr>
<td><strong>Allow User Options</strong></td>
<td>You specify whether or not to display the Options panel on the Account page.</td>
</tr>
</tbody>
</table>

#### Ticket Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Allow user to close</strong></td>
<td>Specifies whether or not users can close tickets.</td>
</tr>
<tr>
<td><strong>Allow user to reopen</strong></td>
<td>Specifies whether or not users can reopen tickets.</td>
</tr>
</tbody>
</table>
Allow user to add a note | Specifies whether or not users can add notes to tickets.

Registration Field Settings
You can add additional user registration fields to the Account page and specify whether or not they are required.

Registration Fields include:
- Company
- Job Title
- Address 1
- Address 2
- City
- County
- State
- Postal Code
- Country
- Telephone

Configuring the Contact Us Page
This page allows you to control the settings on the Contact Us page in an ATG Self Service site.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Contact Us</td>
<td>Specifies whether or not to display the Contact Us page.</td>
</tr>
<tr>
<td>Use CSS</td>
<td>Selects an external or internal CSS for the document page.</td>
</tr>
<tr>
<td>Service Escalation method</td>
<td>You can select the method for Service Escalation from the following list: e-mail, ticket, none</td>
</tr>
<tr>
<td>Pre-fill profile fields checkbox</td>
<td>You can specify whether or not to fill in the Contact Us form fields with the information from the user's profile.</td>
</tr>
<tr>
<td>Show Additional Info to User checkbox</td>
<td>This setting controls the display of another panel with the user's Answers Viewed and Search History.</td>
</tr>
<tr>
<td>Show Escalation Terms</td>
<td>This setting controls the display of your escalation terms.</td>
</tr>
</tbody>
</table>
### Restoring Default Configurations

You can remove all the configurations that you have made to an ATG Self Service site and return it to its original state. Each site configuration page in the Service Admin application includes a Restore to Defaults control.

When you restore default configurations for a site, the settings revert to values that the site inherits. Sites inherit configurations based on a hierarchy. See [Site Settings Hierarchy](#).

The effect of the Restore to Defaults control depends on which site you are configuring. Using the Restore to Defaults control on the main configuration screen for a site affects all the configuration screens for that site. The Restore to Defaults control for a configuration screen within a site affects only that screen. The following diagram and table show the effects of the Restore to Defaults control when used from different configuration screens.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show problem category</td>
<td>This setting controls the display of the problem category used to route help requests to ticket queues.</td>
</tr>
</tbody>
</table>
Restore to Defaults affects configurations differently depending on the screen from which it is used.

<table>
<thead>
<tr>
<th>Configuration Screen</th>
<th>Effect of Restoring Defaults</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Settings main configuration screen (number 1 in the diagram above)</td>
<td>The Restore to System Defaults control will return all configurations for the Default Settings site to the state they were in when you installed ATG Service. This control will affect configurations for individual ATG Self Service sites that you have not overridden. It will not affect site settings that are overridden.</td>
</tr>
<tr>
<td>Configuration Screen</td>
<td>Effect of Restoring Defaults</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Default settings individual configuration screens (number 2 in the diagram above)</td>
<td>The Restore to Defaults control will return all configurations on the configuration screen to the state they were in when you installed ATG Service. It will reset configurations that you have not overridden. It will not affect site settings that are overridden.</td>
</tr>
<tr>
<td>Site main configuration screen (number 3 in the diagram above)</td>
<td>The Restore to Defaults control will return all configurations for the ATG Self Service site to the corresponding values in the Default Settings site.</td>
</tr>
<tr>
<td>Site individual configuration screens (number 4 in the diagram above)</td>
<td>The Restore to Defaults control will return all configurations on the configuration screen to the corresponding values in the Default Settings site. This control will not affect any other configuration screens for the site.</td>
</tr>
<tr>
<td>Site individual configuration screens when a user segment is selected (not shown in the diagram).</td>
<td>The Restore to Defaults control will return all configurations to the corresponding values for the site itself.</td>
</tr>
</tbody>
</table>
7 Targeting Events

ATG Scenario Personalization provides advanced targeting features that companies can use to plan and manage long term personalization and customer relationships. You can use scenarios to enhance your users' experience in your service application and to gather information about how your users are using your ATG Service application.

See information about targeting in the *ATG Business Control Center User's Guide*.

Scenarios in ATG Self Service

ATG Self Service is preconfigured with several service-specific scenario actions and events. You can use these to create scenarios for external users that respond to user actions and customize your ATG Self Service Web sites for those users.

The ATG Self Service server is configured with one Scenario Manager, defined in `/atg/scenario/scenarioManager.xml`. This Scenario Manager handles scenarios for external users.

You configure the `scenarioManager.xml` file to have one Process Editor Server, which is an ATG Self Service instance:

```xml
<?xml version="1.0" encoding="ISO-8859-1" ?>
<process-manager-configuration>
  <process-editor-server>
    <server-name>self_service_host:8851</server-name>
  </process-editor-server>
</process-manager-configuration>
```

Updating External Scenarios

Whenever you create, modify, delete, or start an external scenario, you must propagate that change across your entire ATG Self Service installation.

1. On the ATG Self Service server (`http://self_service_host:port`), locate the `/atg/svc/scenario/ProcessUpdateService` component:
Customizing Scenarios and Messaging

If you are running with ATG Knowledge, and you want to create custom scenario- or messaging-related code, you need to make sure that your code is in modules that are loaded on both servers, and you need to make sure that your data is stored in the appropriate database tables. This includes customizations to any of the following ATG entities:

- event
- action
- slot
- targeter
- message sink
- message source
- any other components referred to by scenarioManager.xml or dynamoMessaging.xml

If your customizations are for external scenarios only, you need to make sure that your ATG Knowledge server loads the code. It is not sufficient to add the customizations to the ATG Self Service server, because the ATG Knowledge server will not notice them, and will fail to launch the external Scenario Manager, causing your customizations to be ignored. Use the scenarioManager.xml file to register such customizations, and load this file on both the ATG Knowledge and ATG Self Service servers.

When creating custom events and actions the ATG Knowledge and ATG Self Service implementations are very similar; they use the same set of methods to work with scenario events. They share the atg.svc.agent.events.EventTools event logging mechanism with minor variations:

- ATG Knowledge uses AgentEventToolsImpl to implement the EventTools class.
- ATG Self Service uses SelfServiceEventToolsImpl to implement the EventTools class.

Note: ATG provides a sample application module to demonstrate custom scenario actions. See information about custom scenario actions for ATG Service events in the ATG Knowledge Configuration Guide.
ATG Self Service Scenario Events

ATG Self Service is configured with the scenario events shown in the following table, which can serve as triggers for scenario actions.

All of the following scenario events have the external user as the implied subject of the scenario.

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Event Description</th>
<th>Attributes Available from the Event Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Views content</td>
<td>Fired from /atg/svc/repository/Service/SessionService:saveAnswer when a solution or document is viewed by a user in ATG Self Service.</td>
<td>Solution ID</td>
</tr>
<tr>
<td>Searches content</td>
<td>Fired from /atg/svc/ui/formhandlers/SearchFormHandler when an Advanced Search is performed. (Regular searching triggers ATG Search events.) You can turn this event on or off with the fireSearchMessage flag on the SearchFormHandler. This event is not recorded by the AuditLogger; ATG Search handles the recording.</td>
<td>KnowledgeQueryContext object and results count</td>
</tr>
<tr>
<td>Browses topic</td>
<td>Fired from /atg/svc/search/SearchService when the topic tree is being browsed. You can turn this event on or off with the fireBrowseSearchMessage flag on the SearchFormHandler. This event is not recorded by the AuditLogger; ATG Search handles the recording.</td>
<td>KnowledgeQueryContext object and results count</td>
</tr>
<tr>
<td>Rates content</td>
<td>Fired from /atg/svc/ui/formhandlers/RatingFormHandler when a user rates an answer. You can turn this event on or off with the fireAnswerMessage flag on the RatingFormHandler.</td>
<td>Comment, Document ID, Document Type, IsContactingSupport, Rating Name, Email Address, Query ID</td>
</tr>
<tr>
<td>Rates query results</td>
<td>Fired from /atg/svc/ui/formhandlers/RatingFormHandler when a user rates a result list. You can turn this event on or off with the fireQueryResultsMessage flag on the RatingFormHandler.</td>
<td>Comment, Rating Name, Email Address, Query ID</td>
</tr>
</tbody>
</table>
JMS Events

This section includes a list of available JMS events (including scenario-enabled events). ATG Self Service events include the following information:

- ProfileId
- ParentSessionId
- SessionId
- EventDate
- OrganizationId
- IPAddress
- EnvironmentName
- SiteName
- RateAnswerMessage
- RateResultsListMessage

<table>
<thead>
<tr>
<th>JMS Event</th>
<th>JMS Type</th>
<th>Available Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>TicketEvent</td>
<td>EscalateTicket</td>
<td>ticket object</td>
</tr>
<tr>
<td>ViewAnswerEvent</td>
<td>ViewedAnswer</td>
<td>answer object</td>
</tr>
<tr>
<td>SearchEvent</td>
<td>Search</td>
<td>KnowledgeQueryContext, result count</td>
</tr>
<tr>
<td>BrowseEvent</td>
<td>Browse</td>
<td>KnowledgeQueryContext, result count</td>
</tr>
</tbody>
</table>

Targeting ATG Self Service Sites

You can configure ATG Self Service sites to present different content to different audiences. To do this, create ATG Self Service user segments and then create personalizations to display specific content.

**Note:** Create separate ATG Self Service sites in the Site Administration utility. The Site Administration utility is in the BCC. See Creating an ATG Self Service Site. Control the solutions that are available at each site using external user segments and the external audience property of the solutions. See Controlling Solution Access at Sites.
Targeting Overview

The quickest method to implement targeting in ATG Self Service is to set up ATG Self Service segments. Segments are comprised of rules that generally identify specific users through properties that have been set in user profiles. Segments are individual elements of a scenario. Create scenarios to manage web visitor interaction. For more information on targeting content, scenarios and segments, refer to the ATG Business Control Center User’s Guide.

Targeting is used to present specific content to a pre-defined audience. However, it is also possible to configure ATG Self Service to target content for anonymous or transient profiles. You can provide different content, look and feel, or redirect to another ATG Self Service site based upon the users who access your site.

For example, within each user profile is a gender parameter. You could create a segment entitled Men, which has a rule that includes only people whose gender is set to male within their user profiles. Whenever a user logs in whose gender parameter is set to male, he is redirected to a site that has been created specifically to display men’s clothing.

Or, you could develop a segment that identifies people who have purchased extended support for a product. To do this, create a segment with a rule that included only people whose brand is Extended Support. Within the user profile, set a user’s brand parameter to Extended Support to allow the user to access solutions that have been identified as available only for those with extended support.

ATG Self Service allows you to set the brand property on a profile that is created by an anonymous user, or a transient profile. You can set the brand for the transient profile by setting a URL parameter, and thus directing the user to specific content. For example, creating a URL http://myselfservice/service/main.jsp?brand=extended_support attaches the Extended Support brand to the transient user session.

Passing Parameters in a URL

You can use the following URL parameters to personalize your ATG Self Service site for any user. Using URL parameters is particularly helpful when working with transient, or unregistered, user:

- **brand**: can be used on a brand selector page
- **locale**: can be used to localize the content
- **segments**: can be used to target the content on the Marketing panel

These parameters are passed in a URL so that a user is directed to the appropriate site, using the following syntax:

1. For the first parameter, append to the URL a question mark (?) and the parameter with its value. For example:
   
   http://hostname:port/service/main.jsp?segments=Segment1

2. To add additional parameters, use the ampersand character (&). For example:
   
   http://hostname:port/service/main.jsp?segments=Segment1&brand=Brand1
**Note:** When a user accesses the site, the `GlobalPageParametersFilter` parameter looks for a page parameter entitled `brand`. If this parameter is present, it sets the brand property on the user profile. For a brand-specific site to be displayed correctly for a logged in user, the brand parameter must be specified in the URL.

**Note:** Create separate ATG Self Service sites in the Site Administration utility. The Site Administration utility is in the BCC. See Creating an ATG Self Service Site. Control the solutions that are available at each site using external user segments and the external audience property of the solutions. See Controlling Solution Access at Sites.

### Populating the Marketing Slot

ATG Self Service includes a Marketing panel with a preconfigured `SelfServiceMarketingSlot` slot and renderer. This panel can be used to display content that can be personalized using the `segments` attribute. For further information on slots, refer to the Using Slots chapter of the ATG Personalization Programming Guide.

To create content for the Marketing panel, create an asset of the type Marketing Item:

1. Create the content you want to use.
2. Use the BCC to create an ATG Content Administration project.
3. Select Add asset to your new project from the project asset tab.
4. Select the `ServiceRepository` and Marketing Item for the Asset Type and select Create New.
5. Enter the properties for the marketing item; available properties are listed in the following table:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>description</td>
<td>A description for the marketing item.</td>
</tr>
<tr>
<td>enddate</td>
<td>Date that you want the marketing item to stop being displayed.</td>
</tr>
<tr>
<td>id</td>
<td>Created automatically by the system.</td>
</tr>
<tr>
<td>imageUrl</td>
<td>URL for the piece of content you want to display.</td>
</tr>
<tr>
<td>linkUrl</td>
<td>URL of the page where you want the user to be directed.</td>
</tr>
<tr>
<td>name</td>
<td>A name for the marketing item.</td>
</tr>
<tr>
<td>segments</td>
<td>Select Add a New Element. Create a segment that will be used as the parameter passed in the URL to the page where the Marketing panel is displayed.</td>
</tr>
<tr>
<td>startdate</td>
<td>Date that you want the marketing item to start being displayed.</td>
</tr>
</tbody>
</table>

6. When you are finished creating the marketing item, click Apply to finish adding the asset to the project.
7. Using the project Task tab, complete and deploy the project.

For additional information on working with and creating slots, refer to the ATG Personalization Programming Guide.
8 Escalation and De-Escalation

ATG Self Service provides escalation and de-escalation mechanisms for ATG Self Service customers.

About Escalation and De-Escalation

Escalation and de-escalation are implemented by the Contact Us page in the ATG Self Service application.

- Escalation shows customers how to contact the call center by one or more methods (such as e-mail or telephone).
- De-escalation provides customers with an opportunity to perform additional research before contacting the call center, and provides some suggestions that may enable them to avoid contacting the call center.

ATG Self Service comes preconfigured with de-escalation reports, which provide information about the percentage of de-escalations and the rate of successful de-escalations. For information about installing de-escalation reports, refer to the ATG Service Installation and Configuration Guide. For information about running de-escalation reports, refer to ATG Self Service Reports, later in this guide.

About Escalation

Escalation provides customers of your ATG Self Service sites with the opportunity to contact the call center in one or more of the following ways:

- E-mail – e-mail is sent to the call center
- Callback – call center representative calls the customer
- Phone – telephone number provided for the call center

You can specify different settings for each segment in your ATG Self Service sites. For example you may want to provide Premium customers with a 24-hour pager number, while Standard customers can only send e-mail. You can also provide multiple listings for each method (for example, multiple phone numbers). The settings are localizable for different user locales.

After the customer submits the form, the following page acknowledges it and supplies a ticket number if applicable. The page also includes search results obtained from performing a new search using the
detailed description information provided by the customer, omitting any results the customer already viewed.

**Enabling Escalation**

Escalation must be enabled in order for customers to see the Contact Us page.

To enable escalation:

1. Open the BCC > Service Admin > Service Admin Configuration > Project Name > Self Service > Site Name > Solutions page.
2. Select the Enable Escalation check list.
3. Save your settings.

**Configuring Escalation**

Escalation is controlled by the `ServiceEscalationAllowEscalate SegmentedOption`, accessible in the Service Administration > Self Service > Site Name > Get Help configuration page. You can configure escalation to occur via Ticket, E-mail or none.

*Note:* When using ATG Self Service with Authoring, the only method of escalation available is e-mail.

**About De-Escalation**

De-escalation provides customers of your ATG Self Service sites with an opportunity to perform additional research before contacting the call center.

De-escalation has the following options, accessible in the Service Administration > Self Service > Site Name > Contact Us configuration page:

- De-escalate only when no solutions have been viewed – de-escalation advice should only occur when the customer’s search has returned zero results
- Number of solutions to show – the number of suggested solutions to show to the customer

When de-escalation is enabled, the Contact Us page initially prompts the user to describe their problem in detail. When the form is submitted, a search is performed with the information from the detailed description provided. Results are displayed as suggested solutions to the customer’s question.

Clicking on the Send to a Customer Representative link displays the following call center contact information:

- E-mail – e-mail is sent to the call center
- Callback – call center representative calls the customer
- Phone – telephone number provided for the call center
You can specify different settings for each segment in your ATG Self Service sites. For example you may want to provide Premium customers with a 24-hour pager number, while Standard customers can only send e-mail. You can also provide multiple listings for each method (for example, multiple phone numbers). The settings are localizable for different user locales.

**Enabling De-Escalation**

De-escalation must be enabled in order for customers to receive the opportunity to avoid contacting the call center.

Escalation is controlled by the `ServiceEscalationEnableDeEscalation SegmentedOption`, accessible in the BCC > Service Admin > Service Admin Configuration > Project Name > Self Service > Segment > Get Help configuration page.

![De-Escalation](image)

**Escalation and De-Escalation JMS Events**

ATG Self Service generates the escalation-related JMS events shown in the following table. By default the escalation and de-escalation events are used only for reporting purposes, but you can configure them to create scenarios in the Scenario Manager; see the ATG Personalization Guide for Business Users for instructions.

<table>
<thead>
<tr>
<th>JMS Event</th>
<th>JMS Type</th>
<th>Available Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>SelfServiceEvent</td>
<td>SessionStart</td>
<td>answer object</td>
</tr>
<tr>
<td></td>
<td>EscalationStart</td>
<td>answer object</td>
</tr>
<tr>
<td></td>
<td>DeescalationAttempt</td>
<td>answer object</td>
</tr>
<tr>
<td></td>
<td>DeescalationItemView</td>
<td>answer object</td>
</tr>
<tr>
<td></td>
<td>DeescalationFailure</td>
<td>answer object</td>
</tr>
<tr>
<td></td>
<td>DeescalationSuccess</td>
<td>answer object</td>
</tr>
<tr>
<td></td>
<td>EscalationComplete</td>
<td>answer object</td>
</tr>
<tr>
<td>JMS Event</td>
<td>JMS Type</td>
<td>Available Details</td>
</tr>
<tr>
<td>------------</td>
<td>--------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>SessionEnd</td>
<td>DurationInSeconds, SessionCreateTime, ProfileId, SessionId, ParentSessionId, IPAddress</td>
<td></td>
</tr>
</tbody>
</table>
9 Advanced User Interface Configuration

The instructions in this section are for users who need to make extensive changes to the user interface of ATG Self Service. This section provides information about the components of user interface that you will need to understand if you are making significant changes to it.

You can customize the ATG Self Service user interface without using these instructions. Use the Service Administration application in the BCC to adjust the HTML, CSS, JavaScript, and basic layout of the user interface. See instructions for this method in Configuring an ATG Self Service Site.

Preparing User Interface Resources

Perform the following steps to prepare to modify the look of the ATG Self Service application:

1. Copy the application style sheet and image directories to the location where you would like them to reside. These directories are in `<ATG10dir>/Service10.0.2/Service/SelfService/reference/`. The location to which you copy them should be Web accessible. This could be in the directory `<ATG10dir>/home/doc/` or any other suitable location.

2. Create a file at `<ATG10dir>/localconfig/atg/svc/self/ui/SelfServiceUIConfiguration.properties` containing the following lines:
   
   ```
   imageLocation=<top-level image directory>
   cssLocation=<css directory>
   ```

   These directories do not have to be local. Note that the subdirectory structure under the image directory, including file names, must be preserved in order for the application to use any changed images without customization of the Web application itself.

   If you need to rename the two style sheets used in the application, add the following lines to `SelfServiceUIConfiguration.properties`:

   ```
   contentStylesheet=<replacement of styles.jsp>
   outerStylesheet=<replacement of outerStyles.jsp>
   ```

   You are now ready to make any desired changes to this style sheet and these images. The running application will reflect those changes.
ATG Self Service also supports the use of themes. To create a new theme, create a new subdirectory of the /css/ directory with the theme name as the directory name. Copy the two application style sheets into this directory and customize them as desired. To reference this theme rather than the default theme, add this line to the SelfServiceUIConfiguration.properties file:

```
theme=<theme name>
```

In this way, you can maintain multiple themes for the application in parallel. Use this mechanism to switch between the themes.

If you want to make these changes to a live configuration, you can edit these properties using the ATG Control Center (ACC) or using ATG Server Admin to browse to this nucleus component. Do this with extreme caution on production systems.

### Customizing Page Layouts

In order to customize the ATG Self Service Web application, you first need to unjar <ATG10dir>/Service10.0.2/Service/SelfService/j2ee-apps/SelfService.ear into a directory called SelfService-ear. You then unjar the file SelfService.war into a directory called SelfService-war in the SelfService-ear directory.

This directory contains the entire ATG Self Service Web application. The content of the application is broken up into the following directories:

- `./` - top level pages of the application including the login page, the home page, and the error pages
- `include/` - Java Server Page (JSP) fragments used as part of other pages
- `include/solution/` - JSP fragments used as part of solution rendering
- `include/mysupport/` - JSP fragments used on the “My Support” page
- `include/search/` - JSP fragments used in rendering the search page
- `css/` - all .css files used in the application. outerStyles.jsp is the style sheet used by all top level pages of the application (including the home page), while styles.jsp is the style sheet for all pages which render in the content iframe of the application.
- `script/` - all JavaScript files used by the application
- `image/` - all images used in the application
- `image/tree/` - images used in the topic tree
- `image/toolbar/` - images used in the solution toolbar
- `image/nav/` - images used as navigation aids in the application
- `image/banner/` - images used as banners for various pages
- `image/bg/` - images used as backgrounds for regions of the application
- `image/button/` - images used as buttons
- **WEB-INF/classes/atg/svc/self/WebAppResources.properties** - the initial resource bundle of the application. This file can be modified to make text changes to the application. It can also be translated to provide localization of the application.

## Testing Application Customizations

In order to test these customizations, it might be convenient to reconfigure the application to use the exploded application directory without needing to re-jar.

**Note:** This may not be supported on some application servers.

## Setting up Customization

Unless you plan to use the sample ATG Self Service application as-is, without any re-branding or incorporation into your existing Web application, you will want to modify the ATG Self Service pages, and perhaps the entire application itself. The following steps allow you to access the application.

1. Use WinZip or the `jar xvf` command to expand `<ATG10dir>/Service10.0.2/Service/SelfService/j2ee-apps/knowledgebase-userexperience.ear` into a directory called `<ATG10dir>/Service10.0.2/Service/SelfService/j2ee-apps/SelfService-ear`

2. Edit the `<ATG10dir>/Service10.0.2/Service/SelfService/j2ee-apps/SelfService-ear/META-INF/application.xml` file as follows:

```xml
<web-uri>_SelfService</web-uri>
```

3. Edit the `<ATG10dir>/Service10.0.2/Service/SelfService/config/atg/dynamo/service/j2ee/J2EEContainer.properties` file as follows:

```properties
applications+={atg.dynamo.root}/Service10.0.2/Service/SelfService/j2ee-apps/SelfService-ear
```

4. In the `<ATG10dir>/Service10.0.2/Service/SelfService/j2ee-apps/SelfService-ear/META-INF/DYNAMO-INF` directory add the following:

```xml
<module-uri>_SelfService</module-uri>
```

**Note:** It is recommended that you repackage the application as an .ear file when you deploy it.

## Displaying New Solution Classes

When you create new solution classes in ATG Service Administration, users can then create solutions of that class in ATG Knowledge. This section describes how to ensure that these solution classes display correctly in ATG Self Service
Important: It is vital that you deploy the solution class itself from ATG Service Administration.

Without customization, ATG Self Service solutions are displayed by a default rendering template provided as part of the ATG Self Service web application. This template displays all data on the solution class in a linear fashion, though you can customize it to control the display of data for classes that do not possess a specialized rendering template.

In most cases, you will want to create a new template to display solutions of the newly created class. In order to do this, create a new .jsp file that correctly renders these solutions. You can either add this file to the /solution/ directory of the ATG Self Service web application, or an external web application that is running on the same server can host the file. Once the new template is available, modify the file solution.jsp with a new option to ensure that the new template is used for solutions of the newly created solution class. For example, if you created a new solution class called SampleClass, which is intended to use a template called solutionSampleClass.jsp, then the file solution.jsp should be modified as follows (Note that this example assumes that you added solutionSampleClass.jsp to the /solution/ directory):

```jsp
<c:choose>
    <c:when test="${solutionBean.solutionClass.id=='SampleClass'}">
        <%@ include file="solution/solutionSampleClass.jspf" %>
    </c:when>
    <c:when test="${solutionBean.solutionClass.id=='SvcSolutionClassFAQ'}">
        <%@ include file="solution/solutionTemplateFAQ.jspf" %>
    </c:when>
    <c:when test="${solutionBean.solutionClass.id=='SvcSolutionClassQuestionAnswer'}">
        <%@ include file="solution/solutionTemplateQA.jspf" %>
    </c:when>
    <c:when test="${solutionBean.solutionClass.id=='SvcSolutionClassBreakFix'}">
        <%@ include file="solution/solutionTemplateBreakFix.jspf" %>
    </c:when>
    <c:otherwise>
        <%@ include file="solution/solutionTemplateDefault.jspf" %>
    </c:otherwise>
</c:choose>
```

Adding Custom Panels

You can add custom panels to the ATG Self Service user interface.

Before you begin, start your ATG Self Service application.

1. Using the ACC or Eclipse, create a new Web application for the customer who needs the custom panel. The Web application’s context root must be /svc-external. Note:
This context root is already configured in `web.xml` so no additional configuration is required to use it.

Everything in a particular panel is implemented in a single JSP. These JSPs can exist in either the ATG Self Service application or any other Web application whose context-root is declared in the ATG Self Service application’s `web.xml` file. The `atg.dynamo.contextPaths` attribute lists all of the context-paths this web application knows about. This enables you to include JSPs from other Web applications. The `DSP:include src="[pagename]"` uses the `param` values specified in this attribute. By default, all ATG Self Service panels are stored in the `/panels` directory.

**Note**: Never put new panels here; use links to external web applications instead.

1. **Create your JSP.** Include any required taglibs. The basic structure for the content should be:

   ```html
   <div class="panel">
       <div class="panelContent">
           [your content here]
       </div>
   </div>
   ```

2. **Build your Web application.**

3. **In the BCC, log in as a user that has permission to access the Service Admin Publishing menu.**

4. **Select Service Admin Publishing > Service Admin to access a deployable project.**

5. **Name the project and click Continue.**

6. **On the Assets tab, click Add asset to project.**

7. **Select Service Repository as the Repository, and select PanelDefinition as the Asset Type. Click Create New.**

8. **Set the following properties as indicated:**

   - `appId`: `selfService`
   - `contentUrl`: `/svc-external/path/to/your/JSP`
   - `panelId`: `panel_id`
     This should be a meaningful and unique value.
   - `helpKey`: `help_id`
     This is optional, but you may wish to use it.
   - `nameKey`: `name_key`
     Used for rendering the panel in the Admin UI.
   - `titleKey`: `title_key`
     Used as the title of the panel in the UI. The `helpKey`, `nameKey`, and `titleKey` are all references into a resource bundle (which values you will create later in this procedure).
10. Click Apply.

11. Click Back to the Project’s Assets.

12. Click Add Asset to Project. Select ServiceRepository as the Repository, and Panel Stack Definition as the Asset Type.

13. Click Add Existing to bring up the Asset Picker, and locate the panel stack to which you want to add the new panel.

14. Select the panel stack. It must be an ATG Self Service panel stack, and should be targeted to segmentName: Everyone-External.

15. Click Add to add the asset to the project, and then click Close. The asset should now appear in your Assets list.

16. Select the new asset. In the list of panelIds, click Add a New Element. Enter the panelId of the panel you are adding. You can move it up or down in the panel stack as necessary. Click Apply.

17. Click Back to the Project’s Assets to return to the Projects page.

18. Select the Tasks tab.

19. In the Actions list, select Check In and Deploy, then click Go. Enter a message if you want in the confirmation dialog, and click OK.

20. Go to the Service.Branding module, and in the lib/resources/atg/svc/branding directory, edit the AtgServiceBrandingResources.properties file. Add the keys you entered above to this file for the panel name, title, etc.

21. Reassemble and deploy your EAR with the new module included, then start your ATG Self Service server. The new panel should be included.

Note: All references in ATG Self Service point back to main.jsp. URL parameters are passed to indicate which tab to render. Any URLs that you include in your panel’s JSP must refer back to main.jsp and pass any attributes used by your page as well as those required by the application. Look at existing panel JSPs for implementation examples.
10 Adding ATG Self Service to an Existing Site

ATG Self Service comes with a sample Web application module and J2EE application that you can use as a starting point for the front-end knowledge base portion of your customer-facing Web application. This chapter outlines the process of integrating that application with your existing site.

Accessing the Application

Unless you plan to use the sample ATG Self Service application as-is, without any re-branding or incorporation into your existing Web application, you will want to modify the ATG Self Service pages, and perhaps the entire application itself. Follow these steps to access the application.

1. Use WinZip or the `jar xvf` command to expand the `<ATG10dir>/Service10.0.2/Service/SelfService/j2ee-apps/selfservice.ear` file into the `<ATG10dir>/Service10.0.2/Service/SelfService/j2ee-apps/selfservice-ear` directory.

2. Edit the `<ATG10dir>/Service10.0.2/Service/SelfService/j2ee-apps/selfservice-ear/META-INF/application.xml` file `<web-uri>` property as follows:

   ```xml
   <web-uri>
     _knowledgebase-userexperience
   </web-uri>
   ```

3. Re-assemble the application into an EAR file and deploy it to the appropriate location. Start your application.

Merging ATG Self Service with another Application

There are two main ways to integrate ATG Self Service into your existing J2EE application:
1. **Merging ATG Self Service with an Existing J2EE Application**

2. **Keeping ATG Self Service as a Separate J2EE Application**

If you are fully integrating ATG Self Service into an existing J2EE application, you might need to make the following modifications.

### Merging ATG Self Service with an Existing J2EE Application

You must combine the ATG Self Service application module and your application module into a single J2EE application with a single context-root. These instructions assume that you are using your own module named `DSSJ2EEDemoSS` with a J2EE application called `QuincyFunds`.

1. Make a copy of your application module and rename it. For example, `DSSJ2EEDemoSS`.
   
   Copy the `<ATG10dir>/Service10.0.2/Service/SelfService/config` directory into the `<ATG10dir>/DSSJ2EEDemoSS/config` directory. Don't overwrite any files. If there are files that overlap, copy the contents of the `.properties` file from ATG Service into your application.

2. Repeat the procedure for the `liveconfig` directory.

3. Copy over the `<ATG10dir>/Service10.0.2/Service/SelfService/lib/classes.jar` file into your `<ATG10dir>/DSSJ2EEDemoSS/lib` directory. If you already have a `lib/classes.jar`, rename the `classes.jar` from `SelfService` to `ssClasses.jar`.

4. In the `<ATG10dir>/DSSJ2EEDemo/META-INF/MANIFEST.MF` file add the following:
   
   `ATG-Class-Path: lib/classes.jar (or lib/ssClasses.jar)`

   If you already have an `ATG-Class-Path` declaration, add a space after the last entry in that line, and add `lib/classes.jar` or `lib/ssClasses.jar` to it.

   Make sure there is an `ATG-Config-Path: config/` line and an `ATG-LiveConfig-Path: liveconfig` line in the file as well.

   Add `PublishingAgent Service.common-ui` to the `ATG-Required:` line.

5. Make an `ss` directory in your root `web-app` folder. For example:
   
   `<ATG10dir>/DSSJ2EEDemo/j2ee-apps/QuincyFunds/web-app/en/ss`

   Copy into this new directory everything from the `<ATG10dir>/Service10.0.2/Service/SelfService/j2ee-apps/selfservice-ear/_SelfService/` directory.

   (This is assuming that you have already followed the directions on how to expand the SS ear file into folders from Accessing the Application.)

6. Except for `web.xml`, move all the files from the `<ATG10dir>/DSSJ2EEDemo/j2ee-apps/QuincyFunds/web-app/en/WEB-INF/*` directory into the `<ATG10dir>/DSSJ2EEDemo/j2ee-apps/QuincyFunds/web-app/WEB-INF/*` directory.

   **Important:** Do not overwrite files if they have the same name.

8. Change the `<ATG10dir>/DSSJ2EEDemo/j2ee-apps/QuincyFunds/web-app/WEB-INF/web.xml` file to add the following filter mappings:

```
<filter-mapping>
    <filter-name>RequireLoginFilter</filter-name>
    <url-pattern>*.jsp</url-pattern>
</filter-mapping>
```

You can now include ss into your application using the following:

```
<dsp:include src="ss/main.jsp"></dsp:include>
```

**Keeping ATG Self Service as a Separate J2EE Application**

If you choose to keep ATG Self Service as a separate J2EE application, you will need to add the ATG Self Service context-root `/service` to the `contextPaths` parameter of your J2EE application. In the `web.xml` file of your application, you will need to add `/service`. For example:

```
<context-param>
    <param-name>atg.dynamo.contextPaths</param-name>
    <param-value>/QuincyFunds:/service</param-value>
</context-param>
```

**Using Frames**

If you are incorporating ATG Self Service pages into an existing J2EE application using frames, there are no modifications that you will need to make if ATG Self Service is in its own frame. You only need a line similar to the following:

```
<frame src="/service/main.jsp" name="ss" id="ss">
```

**Enabling Single Log In**

If you incorporate ATG Self Service into your existing Web application, you can configure it so that users only have to log in once.

If your Web site has its own authentication mechanism, there are basically three parts to integrating ATG Self Service into a single sign-on scheme.

First, you must integrate the ATG `UserProfileRepository` with your user profile data. You can do this by mapping the repository description of ATG `UserProfileRepository` onto your user profile database tables.

The second part is to implement single sign-on in ATG Self Service. This should be done by creating a servlet that tests if a user is signed on and placing it in the `SelfService.SelfService` servlet chain.
If the user is not signed on, he is redirected to the appropriate login page. If a user is signed on, then the following code is executed in the servlet to log the user into ATG Self Service:

```java
import atg.servlet.ServletUtil;
import atg.userprofiling.Profile;
import atg.userprofiling.IdentityManager;

IdentityManager getIdentityManager()
{
    return (IdentityManager)ServletUtil.getCurrentRequest().resolveName
        (getUserLoginManager().getIdentityManagerPath());
}

UserLoginManager getUserLoginManager()
{
    return (UserLoginManager)ServletUtil.getCurrentRequest().resolveName
        ("/atg/dynamo/security/UserLoginManager");
}

Profile profile = (Profile)ServletUtil.getCurrentRequest().resolveName
    ("/atg/userprofiling/Profile");
profile.getProfileTools().locateUserFromLogin(<username>, profile);
profile.getProfileTools().assumeSecurityIdentity(profile,
    getIdentityManager());
```

**Logging Out**

For logging users out, you should disable log out from ATG Self Service by hiding the link. Otherwise, you need to make sure that the logout action from ATG Self Service logs out the user from your single sign-on scheme.

To do this, you need to subclass `atg.userprofiling.ProfileFormHandler`, and in that class, override `ProfileFormHandler.postLogoutUser(DynamoHttpServletRequest, DynamoHttpServletResponse)`, making sure to call `super.postLogoutUser(request, response)` in the last line of that function.

Then override the Nucleus configuration for `ProfileFormHandler` to point at your subclass by creating a file in `<ATG10dir>/localconfig/atg/userprofiling/ProfileFormHandler.properties` that contains one line:

`$class=com.acme.MyProfileFormHandler`

Set `com.acme.MyProfileFormHandler` to the name of your subclass of `ProfileFormHandler`.

The `postLogoutUser` method will be called after the logout button is clicked in ATG Self Service. Therefore, whichever code logs a user out of your single sign-on scheme is the code that should be invoked by the `postLogoutUser` method.
Integrating with a non-ATG Site

If you are running your Web site without using ATG, you can still integrate it with ATG Self Service.

For example, you could be running your Web site on one server without ATG and then run ATG Self Service (with Adaptive Scenario Engine) on a different server. When users are on the non-ATG Web site, they must be able to access ATG Self Service, so you need to be able to point at ATG Self Service from a non-ATG Web site.

To achieve this, both of your servers must use the same data and the same user profile information.

The ATG Adaptive Scenario Engine supports this kind of configuration. You must map the ATG Self Service repositories and any other ATG repositories to the tables of the database on your non-ATG server. Once this is done, the data is in sync.

ATG Professional Services can provide support in setting up such a configuration.


t

ATG Self Service comes preconfigured with de-escalation reports, which provide information about the percentage of de-escalations and the rate of successful de-escalations. For more information about installing ATG Self Service reports, refer to the ATG Service Installation and Configuration Guide.

You access ATG Self Service reports in the ATG Control Center (ACC). For information about the support, refer to the ATG Business Control Center Administration and Development Guide.

This section describes server-side requirements for configuring, and running ATG Self Service Reports.

- Before starting this chapter, ensure that you have configured ATG Reporting as described in Chapter 7 of the ATG Service Installation and Configuration Guide and imported the reports and metadata as described in Chapter 5 of the ATG Customer Intelligence Installation and Configuration Guide.

- For information on ATG Customer Intelligence, refer to the ATG Customer Intelligence Installation and Configuration Guide.

- To learn how to access ATG Self Service Reports, refer to the ATG Customer Intelligence Reporting Center User Guide.

Setting the Reporting Summary Service Schedule

The Reporting Summary Service summarizes data on a schedule determined by a setting a line in the schedule property in the /atg/svc/ReportingSummaryService component. The default setting is every half hour as denoted by the syntax calendar schedule=calendar * * * * 2 30.

The ReportingSummaryService component is available only on the data warehouse loader server, where the Service.KnowledgeDataWarehouse module is running.

To change this setting:

1. Open the ReportingSummaryService component in the ACC.
2. Modify the configured value of the schedule property.

To understand the syntax, consult the ATG Customer Intelligence Data Warehouse Guide.
About ATG Self Service Reports

This section describes the reports available with ATG Self Service.

De-Escalation Reports

ATG Self Service includes a De-Escalation Report, which you can view in the ATG Reporting Center. The De-Escalation Report provides the percentage of de-escalations and the rate of successful de-escalations across a given date range. You can choose which ATG Self Service sites are included in the report.

To view the report, select the date range, frequency, and ATG Self Service sites that you would like to see in the report:

- Date Range – Start to End
- Frequency – hourly, daily, weekly, monthly, quarterly, yearly
- Site – select one or more ATG Self Service sites

The report graph shows the following data for the time period and frequency chosen:

- De-escalation percentage = successful de-escalations / attempted de-escalations
  This statistic shows how many attempted de-escalations resulted in success, including pending (incomplete) de-escalations.
- De-escalation success rate = successful de-escalations / (successful de-escalations + unsuccessful de-escalations)
  This statistic shows how many de-escalations resulted in success, excluding pending (incomplete) de-escalations.

The chart below the graph shows the following data for the time period and frequency chosen:

- Sessions initiated
- Attempted escalations
- Attempted de-escalations
- Completed escalations
- Successful de-escalations
- Unsuccessful de-escalations
- De-escalation percentage (also shown in graph)
- De-escalation success rate (also shown in graph)

Note: It is not possible to use this report to track a single or specific user session. The report is a snapshot of aggregate data. Since a session can cross time boundaries when reporting data is summarized, the report statistics do not reveal precise details about individual sessions.
Index

A
accounts, configuring, 37
administration, site, 23
anonymous user access, 22
attachments, deploying, 14

B
best bets
configuring, 16
browse page, 35

C
categories, defining, 15
configuring
  best bets, 16
  hot solutions, 16
  top questions, 16
contact page, 38
cookies, filtering, 22

d-e-escalation
  and JMS events, 53
  enabling, 53
  overview, 52
  reports, 69
default
e-mail text, 30
  hot solution display, 17
language, 29
user option, 30
document page, 36

E
e-mail
default text, 30
  site administrator, configuring, 23
  site landing page, 23
escalation
  and JMS events, 53
  enabling, 52

H
hot solutions
  configuring, 16
  default display, 17

J
JMS events, 45
  and escalation, 53
  JVM, running separate, 9

L
language
  configuring multi-, 29
  default, 29
language localization
  root topics, 30
localization
  root topics, 30

M
marketing slots, 48
messaging, scenarios, 44

P
P3P, 22
page
  accounts, 37
  browse, 35
  contact, 38
docs, 36
documents, 36
home, 32
layout customization, 57
search, 33
solutions, 36
panels, adding, 59
production
  running, 17
server requirements, 17
R
reports, 68
accessing, 68
de-escalation, 69
summary service schedule, 68
root topics
assigning for an ATG Self Service site, 30

S
scenarios, 43
and messaging, 44
events, 45
external, 43
search
advanced options, 34
configuring, 33
segments
prerequisites, 18
removing, 19
sites
administration, 23
creating multiple, 24
home page, configuring, 32

landing page and e-mail, 23
layout, 33
panel configuration, 33
root topics for, 30
skin configuring, 27
defaults, 28
modifying, 28
slots, marketing, 48
solutions
attachments, deploying, 14
classes, new, 58
page, 36
style sheets
site home page, 32

T
ticket queues, 15
top questions
configuring, 16

U
user interface customization, 56